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MOBILE CHECKLIST C: CONFIGURE EDITING 
IMPORTANT: Before beginning the Mobile editing process, complete all steps 
listed in Mobile Checklist A: Preparation and Mobile Checklist B: Configure 
Replication.   

IMPORTANT: This document provides instructions for configuring Mobile 
implementations which allow editing of graphics, features, and/or CUs, namely 
Basic Redliner, Advanced Redliner, Inspector, Mobile ArcFM, and Mobile 
Designer.  If implementing ArcFM Viewer View-Only, these steps are not 
necessary and should not be done. 

PART 1: CONFIGURING PROCESS FRAMEWORK  

STEP 1:  CONFIGURE THE ENTERPRISE PROCESS FRAMEWORK 
DATABASE FOR MOBILE  
In this step, you will export the enterprise Process Framework database 
settings to XML twice: once to backup the existing settings, and once to 
create an external record of the new settings.  Between the two exports to 
XML, you will add various settings required by Mobile.  

 On the  Enterprise Client, double-click 
ProcessFrameworkSampleData_<version>.exe  
to unzip it. 

First, you will import enterprise workflow information  necessary for 
supporting Mobile editing into the enterprise PX database. 

 From the  Start  menu choose  Programs > ArcFM 
Solution > Process Framework > Administration  
> Process Framework Administration Tool.  

 Click  [ Connection ]  if necessary to expand the 
dialog. 

 For  DBMS Provider  choose  MS Access OLEDB. 

 For  User Name  enter  process 

 For  Database Name,  browse to   C:\Program 
Files\Miner and Miner\ArcFM Solution\Sample 
Data\Databases\Session Manager.mdb  or if 

By default, the self-extracting 
ProcessFrameworkSampleData_ 
<version>.exe places four Process 
Framework databases in   
C:\Program Files\Miner and 
Miner\ArcFM Solution\ 
Sample Data\Databases. 

 

etc 
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implementing Mobile Designer or Designer Redliner, 
choose  Workflow Manager.mdb.  

 

 Double-check that you have chosen 
SessionManager.mdb or Workflow Manager.mdb, NOT 
Field SessionManager.mdb or Field Workflow 
Manager.mdb. 

 Click  [ Login ]. 

 When the  Process Framework Administration  
tool appears, display the  Import/Export  tab.  

 Choose the  Export  radio button.  

 Check the box for  Process Framework Workflow    
or  Process Framework Import/Export Tool, 
whichever is offered. 

 Under  File to contain exported data,  browse to a 
convenient location on the Enterprise Client and specify 
a file name , e.g. From Sample Session 
Manager.xml 

 Click  [ Save ]. 

If the login fails, click  [ Test ]   
for more information. 

tip 
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 In the  Process Framework Administration  tool 
window, click  [ Export ]. 

 

 When prompted, choose to export the  
MMSessionManager  extension.  If implementing 
Mobile Designer or Designer Redliner, export the 
MMWorkflowManager  extension. 

 Click  [ Export ].  

 Click  [ OK ]  to the export completion message. 
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 Close the  Process Framework Administration  
tool. 

Before altering the enterprise configuration, you will first run any 
available updates for the enterprise Process Framework database.   

Mobile relies on the correct and complete configuration of the enterprise 
Process Framework database.  The Process Framework Database 
Upgrade Tool informs you after each upgrade task when additional work 
is necessary, such as setting permissions on newly created tables.  At a 
client site, you should read carefully all information provided during the 
upgrade process, and complete any required follow-up tasks.  Otherwise, 
you may encounter errors requiring considerable time to diagnose. 

 Still on the Enterprise Client, from the  Start  menu 
choose Programs > ArcFM Solution > Process 
Framework > Administration > Process 
Framework Database Updater.  

 Click  [ Connection ]  if necessary to expand the 
dialog. 

 For  DBMS Provider  choose  MS SQL Server 
OLEDB  or  Oracle. 

 For  User Name  enter  process 

 For  Password  enter the correct password for user 
process.  

 For  Server  enter the name of the  database server 
(e.g. vm-mobileed\mobile). 

 If using SQL Server, for  Database Name  enter the 
database name (e.g.   process). 
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 Click  [ Login ]. 

 When the  Process Framework Database 
Upgrader  window opens, expand the list of  
Available Upgrade Tasks. 

 

 Choose the first task in the list. 

 Click  [ Execute Task ].  

 Examine the information in the  Messages  field 
carefully.  If any follow-up tasks such as setting table 
permissions are required, note them and complete 
them before proceeding further with Mobile 
configuration. 

 Run  [ Execute Task ]  for each remaining task in the 
list.  If prompted to choose an SDE Database 
Connection, browse to the enterprise SDE geodatabase 
connection using the  sde.DEFAULT  version, as user 
sde.  For each task, read the  Messages  information 
and complete the appropriate follow-up tasks.  
Skipping the follow-up tasks may prevent Mobile from 
functioning correctly. 

If the login fails, click  [ Test ]   
for more information. 

After you run some upgrade tasks, 
new ones may appear.  For 
example, after running a 9.1.2 
upgrade, the 9.2 upgrade will be 
added to the list and will also need 
to be run. Some upgrade tasks, 
including Create Table Indices, 
will remain in the list even after 
you run them. 

tip 

tip 

If you are unsure whether a particular 
Upgrade Task has been run yet, run it 
again.  Running the same task on a 
database multiple times is harmless, 
but failing to run a task may cause 
problems later. 

tip 
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 When you have run all available upgrade tasks, close 
the  Process Framework Database Upgrade  tool.  

 Still on the Enterprise Client, from the  Start  menu 
choose  Programs > ArcFM Solution > Process 
Framework > Administration > Process 
Framework Administration Tool.  

 Log in to the to the enterprise Session Manager 
database using the same connection information as 
you entered into the PX Database Updater Login 
screen. 

Before making any changes, export the current settings to XML. 

 Display the  Import/Export  tab.  

 Choose the  Export  radio button.  

 Check the boxes for  Process Framework Workflow 
(or  Process Framework Import/Export Tool)  
and  Users.  If implementing Mobile Designer, also 
check the box for  Workflow Manager CUs. 

 

 Under  File to contain exported data,  browse to a 
convenient location on the Enterprise Client and specify 
a file name. 

 Click  [ Save ]. 
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 In the  Process Framework Administration  tool 
window, click  [ Export ]. 

 When prompted, choose to export only the  
MMSessionManager  workflow.  If implementing 
Mobile Designer, choose to export only the 
MMWorkflowManager  workflow. 

 

 Click  [ Export ].  

 When prompted, choose to export information for all 
users. 

 

 Click  [ OK ]. 

 Click  [ OK ]  to the export completion message. 
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Now that the original settings have been backed up, you will import the 
Mobile workflow which you earlier exported from the sample Session 
Manager database.  

 Choose the  Import  radio button.  

 Under  XML file to import,  browse to  From 
Sample Session Manager.xml. 

 Click  [ Import ]. 

 When prompted, choose  Append Data. 

 

 Click  [ OK ]. 

 Scroll to the bottom of the log field to verify that the 
import was successful. 

 

 Choose the  Extensions  tab. 

 For  Database ID  enter a value identifying this 
database (e.g.  TheDatabaseID). 
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All Process Framework databases that can exchange Sessions with each 
other must have the identical DatabaseIDs.  The Database ID can be any 
text string. Later you will enter exactly the same DatabaseID value in the 
field Process Framework database. 

 Display the  Node Types  tab. 

 Check the  Show Filter node types  box. 

 Select the  Session  node.  For a Mobile Designer 
implementation, select the  Design  node. 

 Confirm that the  Tasks  list below includes a  Send 
Session  (or  Design) to Field  task. 

 

 If the  Send Session to Field task 
is missing, click Add Task. In the Task 
Properties dialog, name the new task 
Send Session to Field and check 
Visible in Task Tool.  From the 
Available Subtasks list, add (in this 
order): 
  
 Is Mobile Solution Enabled? 
 Change Session Owner To Mobile 
 Create Packet 
 Send Session to Field   
 
From the Transition drop-down, 
choose Mobilize Session.  If there is no 
Mobilize Session transition, you will 
need to add it to the Transitions tab 
before using it in the Task Properties. 
On the Transitions tab, add a Mobile 
Session transition, then in From States 
check In Progress, for To State choose 
Mobile, and allow the following roles 
to execute this transition: Session 
Editor, Session Administrator, Session 
Approval Officer, Session ALWAYS 
Mobile User, and Session Mobile 
User.  Return to the Send Session to 
Field Task Properties and choose 
Mobilize Session as the Transition. 

etc 
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 In the  Node Types  (top) list select  
AllSessionsFilter.  For a Mobile Designer 
implementation, select  AllWorkRequests. 

 Confirm that the  Tasks  list below includes a 
Send/Receive Mobile Data  task. 

 Confirm that each of the other filters - 
UserSessionsFilter  and  
UserStatusSessionsFilter  - has a Send/Receive 
Mobile Data task.   For a Mobile Designer 
implementation, confirm this for the filters  
UserWorkRequests  and 
UserStatusWorkRequests. 

 Select the  AllSessionsFilter  and its  Create 
Session  task. 

 

 Click  [ Properties ]. 

 In the  Available Subasks  list, double-click the  
Create Packet  subtask.  

 In the  Selected Subtasks  list, make sure that  
Create Packet  is listed under  Create Session. 

If the  Send/Receive Mobile 
Data  task is missing from any filter, 
click Add Task. In the Task Properties 
dialog, name the new task 
Send/Receive Mobile Data and check 
Visible in Task Tool.  From the 
Available Subtasks lists, add (in this 
order):  
  
 Is Mobile Solution enabled? 
 Is Enterprise Disk Full? 
 Mobile Synchronize 
 Update Enterprise 
 Mobile Synchronize 
 
From the Transition drop-down, 
choose None.  Under Task Roles, 
check Session Editor and Session 
Approval Officer. 

etc 
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 Click  [ OK ]. 

 For UserSessionsFilter  and  
UserStatusSessionsFilter,  add the  Create Packet 
subtask to the  Create Session  task, each time 
making sure it is listed after the  Create Session 
subtask. 

 On the  Configuration  tab, add the following name-
value pairs EXACTLY as shown below (substituting your 
actual base path for “\\vm-mobileed\TheContainer\ 
TheBaseFolder”).  If these values are already present, 
update them to match the values shown below: 

Name Value 

Px_MobileDatabase 0 

ProcessFrameworkEnterprise \\vm-mobileed\ 
TheContainer\TheBaseFolder

SessionEnterpriseAfterImportTask After Session Import 
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 For a Mobile Designer implementation, add the name 
WMSEnterpriseAfterImportTask  with the value  
After Design Import 

The PX_MobileDatabase value of 0 indicates that this is an enterprise 
Process Framework database.  The SessionEnterpriseAfterImport task 
runs any follow-up tasks needed after Sessions are received from the 
field.  

Next you will backup your new settings. 

 From the  File  menu choose  Save. 

 Display the  Import/Export  tab.  

 Choose the  Export  radio button.  

 Check the boxes for  Process Framework Workflow  
and  Users.  If implementing Mobile Designer, also 
check the box for  Workflow Manager CUs. 

 Under  File to contain exported data,  browse to a 
convenient location on the Enterprise Client and enter  
a file name. 

 Click  [ Save ]. 

The exported file can be given any 
filename valid in the Windows 
operating system.  Make sure the 
name distinguishes it from the file 
you exported earlier containing the 
initial, pre-mobile PX settings. 

tip 
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 In the  Process Framework Administration  tool 
window, click  [ Export ]. 

 When prompted, choose to export the  
MMSessionManager  workflow. If implementing 
Mobile Designer, choose to export only the 
MMWorkflowManager  workflow. 

 

 Click  [ Export ].  

 When prompted, choose to export information for all 
users. 

 Click  [ OK ]. 

 Click  [ OK ]  to the export completion message. 

 From the  File  menu, choose  Save. 
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 Close the  Process Framework Administration  
tool. 

STEP 2:  CONFIGURE THE FIELD PROCESS FRAMEWORK DATABASE 
FOR MOBILE  

 Still on the Enterprise Client, from the  Start  menu 
choose  Programs > ArcFM Solution > Process 
Framework > Administration > Process 
Framework Database Updater.  

 If necessary, click  [ Connection ]  to expand the 
dialog. 

 For  DBMS  Provider,  choose  MS Access OLEDB. 

 For  User Name  enter  process  

 For  Database Name,  click the  Browse  (three dot) 
button and navigate to  Field SessionManager.mdb  
(for Mobile Designer or Designer Redliner, use  Field  
WorkflowManager.mdb)  in  Program Files\ 
Miner and Miner\ArcFM Solution\Sample 
Data\Databases. 

Be careful to choose the right Field database, not SessionManager.mdb 
or WorkflowManager.mdb.  

 Click  [ Open ]. 

 

 Click  [ Login ]. 

Consider moving the Field 
SessionManager.mdb file to a 
different location to keep the 
ProcessFrameworkSampleData.exe 
from overwriting this database the 
next time it is unzipped. 

tip 
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 For each  Available Upgrade Task,  click  [ Execute 
Task ].  If prompted for an SDE Database Connection, 
cancel the task and try the next available task.  

 

 When you have run or cancelled all available upgrade 
tasks, close the  Process Framework Database 
Upgrade  tool.  

 Still on the Enterprise Client, from the  Start  menu 
choose  Programs > ArcFM Solution > Process 
Framework > Administration > Process 
Framework Administration Tool.  

 Log in to the  Field SessionManager.mdb  (or Field 
WorkflowManager) database using the same 
connection information as you entered into the PX 
Database Updater Login screen. 

 

First you will set the DatabaseID to be identical to the DatabaseID you 
chose in the enterprise process framework properties.  If the two 
DatabaseIDs are not identical, Send/Receive will fail.    

 Display the  [ Extensions ]  tab. 

 For  DatabaseID  enter the database ID (e.g. 
TheDatabaseID). 
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Because you started with the sample Field SessionManager.mdb (or 
Field WorkflowManager.mdb) database, all necessary Node Tasks are 
already present.   However, any unnecessary enterprise-only tasks should 
be deleted. 

 Display the  Node Types  tab. 

 Select the  Session  node (for Mobile Designer or 
Designer Redliner, select  Design). 

 If any of the following tasks appear in the Task list, 
delete them:  

Send Session to Current Field Owner  
Send Session to Field 
Conflicts Report 
Edit Log Report 

 Next you will set the Name/Value pairs needed by Mobile.  

 Display the  Configuration  tab. 

The  Send Session to Current 
Field Owner  task should only 
appear in enterprise, not field 
Process Framework databases.  

etc 
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 Add or edit the following name-value pairs to make 
them EXACTLY as shown below (substituting your 
actual base path for “\\vm-mobileed\TheContainer\ 
TheBaseFolder”).  If these values are already present, 
update them to match the values shown below: 

Name Value 

Px_MobileDatabase 1 

ProcessFrameworkEnterprise \\vm-mobileed\ 
TheContainer\TheBaseFolder 

SessionEnterpriseAfterImportTask After Session Import 

 

 For a Mobile Designer implementation, add the name 
WMSEnterpriseAfterImportTask  with the value  
After Design Import 

 Add the  ProcessFrameworkField  name, and set 
the value to a folder that will not be needed by other 
software (e.g. C:\TheContainer).  If this folder does 
not already exist, create it. 

 

 From the  File  menu, choose  Save.  

 Close the  Process Framework Administration  
Tool. 

 Still on the Enterprise Client, start  ArcCatalog. 
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 Using ArcCatalog, copy  Field SessionManager.mdb  
(or  Field WorkflowManager.mdb)  to the Field Unit 
base directory (e.g. Y:\TheContainer\TheBaseFolder). 

 

STEP 3:  TEST THE FIELD PROCESS FRAMEWORK DATABASE  

Implementation-Specific Steps 
Applies to: Implementations on the ArcMap platform 

Mobile ArcFM, Mobile Designer 
 

 On the  Field Unit,  start  ArcMap. 

 In the ArcFM or Designer login screen, browse to the 
Login  database. 

 Apply a Stored Display. 

 Open  Session Manager  or  Workflow Manager. 

 Create a new Session or Design. 

 Delete the Session/Design. 

 Close  Session Manager  or  Workflow Manager. 

 Close  ArcMap. 

 Skip all instructions below regarding the  ArcFM Engine 
Administrator  and  ArcFM Viewer for ArcGIS Engine 
and jump to the next step. 

 

 On the  Field Unit,  from the  Start  menu choose 
Programs > ArcFM Solution > ArcFM Engine 
Administrator.  
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 Display the  Login  tab. 

 Expand  Login Connections. 

 Select the login connection you created earlier.  

 

 On the right side of the window, under  Process 
Framework, click  [ Browse ]. 

 If necessary, click  [ Connection ]  to expand the 
dialog. 

 For  DBMS Provider, choose  MS Access OLEDB. 

 For  User Name  type  process 

 For  Database Name, browse to the  Field 
SessionManager.mdb  (or  Field 
WorkflowManager.mdb)  database in the Field Unit 
base path  C:\TheContainer\TheBaseFolder. 

 

 Click  [ Open ]. 
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 In the  Field SessionManager  window click  
[ Login ]. 

 

 Display the  Layout and Licenses  tab. 

 Expand  Licenses. 

 Confirm that the correct licenses are checked. 

 

 Click  [ Apply ].  

 Click  [ OK ]  to close the  ArcFM Engine 
Administrator. 
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 Still on the Field Unit, from the  Start  menu choose 
Programs > ArcFM Solution > ArcFM Viewer for 
ArcGIS Engine. 

 Choose the  CourseLoginConnection. 

 For  User Name  enter a configured end-user login 
(that is, a user who has been granted appropriate 
permissions in the Process Framework database).  

 

 Click  [ OK ]. 

 In the  ArcFM Viewer for ArcGIS Engine  window, 
show the  Session Manager  toolbar, if necessary. 

 On the  Session Manager  toolbar, click  Open 
Session Manager. 

 When the Session Manager window appears, from the 
filter list on the left choose  My Sessions. 

 

 In the central “tree” section, right-click the  My 
Sessions  node and choose  Create Session. 

The  User Name  you specify in 
the ArcFM Viewer for ArcGIS 
Engine login screen will also be 
your Session Manager (or 
Workflow Manager) user name 
and so should be included on the 
Users tab in the Process 
Framework Administrator Tool.  
You will only be able to open 
Sessions owned by the user you are 
currently logged in as.  If you enter 
the wrong user name, you can 
change identities later in the 
Session Manager window by 
opening the File menu and 
choosing Login, then specifying a 
different User Name. 

           Look for the  Open 
Session Manager  button on the 
Session Manager toolbar.   

I 

tip 
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 Right-click the newly created session and choose 
Delete Session. 

 When prompted to confirm the deletion, click  [ Yes ]. 

 

PART 2: CONFIGURING SEND/RECEIVE 

STEP 1:  TEST MANUAL SEND/RECEIVE 
 

 Still on the Field Unit, create and open a new Session 
or Design. 

 Draw some ink on the map and/or edit features as 
permitted by your implementation. 

 Save and close the Session/Design. 

 Open Session Manager  or  Workflow Manager. 

 Expand the top node. 

 

 Select the Session or Design you just created. 

 From the  Available Tasks  drop-down choose   
Send Session to Enterprise. 
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 Click the green  Execute Selected Task  button. 

 When prompted to select a new owner, choose an 
enterprise user with the role of Approval Officer. 

 

 Click  [ OK ].  

 Select the top node. 

 From the  Available Tasks  drop-down choose 
Send/Receive Mobile Data. 

 

 Click the green  Execute Selected Task  button. 

 Observe that your Session or Design is no longer listed. 

 Close  Session Manager  (or  Workflow Manager) 
and  ArcFM Viewer for ArcGIS Engine  or  
ArcMap. 

 On the  Enterprise Client,  start  ArcMap. 

 In the  Login to ArcFM  screen, connect to the 
enterprise SDE geodatabase  Sync  version as the 
enterprise user with the role of Approval Officer (the 
same user to whom you just sent the Session/Design). 

 Apply a  Stored Display. 

            Look for the  Execute 
Selected Task  button beside the 
list of Available Tasks.  

I 
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 Show the  ArcFM Session Manager  toolbar,  if 
necessary. 

 Open Session Manager. 

 If prompted, login with the same user name and 
password. 

 

 In the filter list on the left, choose  My Sessions  (or  
My Designs). 

 In the tree, select the top node. 

 From the  Available Tasks  drop-down choose 
Send/Receive Mobile Data. 

 Click the green  Execute Selected Task  button. 

 When the Session or Design you sent from the field 
appears in the list, select it.   

 From the  Available Tasks  drop-down choose   
Open Redline Session.  

 Click the green  Execute Selected Task  button. 

 On the map, view the redlining or editing that was 
originally done in the field. 

 For further testing, create a new Session or Design on 
the Enterprise Client. Run  Send Session to Field  on 
the new Session or Design, and choose the field user.  
Select the top node  (My Sessions  or  My Designs)  
and run  Send/Receive Mobile Data. 

 On the  Field Unit,  login as the field user and run  
Send/Receive Mobile Data.  The new Session or 

If the Session does not reach the 
Enterprise Client user, check the 
Event Viewer on all three 
machines.  You may need to create 
the Enterprise Server and/or Field 
Unit  Working Dir  folders 
manually.  

I 
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Design (created on the Enterprise Client) should now 
be visible in the tree. 

STEP 2:  CONFIGURE AUTOMATED SEND/RECEIVE VIA PROCESS 
FRAMEWORK REPLICATION 
This step is optional but highly recommended.  In Mobile versions 9.3 
SP1 and earlier, ArcFM Desktop must be installed (although no ArcFM 
Desktop license is needed) on the Replication Server for this process to 
succeed. 

 On the  Replication Server,  from the  Start  menu 
choose  Programs > ArcFM Solution > ArcFM 
Geodatabase Replication > ArcFM Geodatabase 
Replication Administrator. 

 From the  File  menu choose  Open Configuration 
File. 

 Browse to  Program Files\Miner and Miner\ArcFM 
Solution\Bin\ReplicationConsole.exe.config. 

 Right-click  General Category  and choose  New > 
Process Framework Replica Server.  

 Select the  Process Framework Replica  node. 

 For the  Replica Name  enter a new replica name 
(e.g.  TheSendReceiveReplica). 

 Verify that  Enabled  is set to True. 

 For the  Database Name  connect to the  enterprise 
PX database  as a user with the Approval Officer role.  

 

 Click  [ Login ]. 

When browsing for the field or 
enterprise PX database, the user 
account used to connect must have 
permission to execute the 
Send/Receive Mobile Data 
task.  

I 
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 Save the settings, correct any errors, and close the  
ArcFM Geodatabase Replication Administrator. 

During automated Send/Receive, the Replication Server accesses the 
enterprise Process Framework database.  To verify that the Replication 
Server has the necessary permissions, and to initialize some Windows 
Registry keys, you will  open the stand-alone Process Manager tool. 

 From the  Start  menu, choose  Programs > ArcFM 
Solution > Process Framework > Process 
Manager. 

 Connect to the  enterprise PX database  as the 
same user you specified in the ArcFM Geodatabase 
Replication Administrator. 

 

 Click  [ Login ]. 

The Session Manager interface should appear. 

 

 If any error messages appear, resolve them before 
continuing. 

Opening stand-alone  Session 
Manager  or  Workflow 
Manager  on the Replication 
Server verifies that the server has 
the necessary permissions to run 
Process Framework processes, and 
initializes some Windows Registry 
keys. 

etc 
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 Close  Session Manager. 

Next you will enter the necessary settings on the Field Unit to trigger 
Send/Receive during client-side replication. 

 On the  Field Unit,  from the  Start  menu choose  
Programs > ArcFM Solution > ArcFM 
Geodatabase Replication > ArcFM Geodatabase 
Replication Administrator. 

 From the  File  menu choose Open Configuration 
File. 

 Browse to  Program Files\Miner and Miner\ArcFM 
Solution\Bin\ReplicationConsole.exe.config. 

 Right-click  General Category  and choose  New > 
Process Framework Replica Client.  

 Select the  Process Framework Replica  node. 

 For the  Replica Name  enter the name you set on 
the Replication Server, e.g.  
TheSendReceiveReplica 

 Verify that  Enabled  is set to True. 

 For the  Database Name  connect to the  Field 
Session Manager  (or  Field Workflow Manager)  
database as the field user who will use this machine. 

 

 Click  [ Login ]. 

 Save the settings, correct any errors, and close the  
ArcFM Geodatabase Replication Administrator. 

The Process Framework replica 
for use with Send/Receive is a 
different replica than the Backdrop 
geodatabase replica, and so must 
have a different Replica Name.  
Both the Replication Server and 
Field Unit Process Framework 
replicas must have the same 
Replica Name. 

etc 
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With the new replica configured on both the Replication Server and the 
Field Unit, you can now test automated Send/Receive. 

 Still on the Field Unit, start  ArcFM Viewer for 
ArcGIS Engine  or  ArcMap. 

 From the  Stored Items List,  choose a Stored 
Display. 

 Create a new Session/Design and draw ink or make 
edits in it.  

 Save and close the Session/Design. 

 Open Session Manager  or  Workflow Manager. 

 Select the Session/Design you just created  
(NOT the top node). 

 From the  Available Tasks  drop-down choose  Send 
Session to Enterprise. 

 Click the green  Execute  button. 

 When prompted to select a new owner, choose the 
enterprise user with the role of Approval Officer. 

 Click  [ OK ]. 

Notice that you are not going to choose Send/Receive Mobile Data.  
Instead, you will run ArcFM Geodatabase Replication Client, and it will 
trigger Send/Receive because of the Process Framework replica you 
configured.  

 Close  Session Manager/Workflow Manager  and  
ArcFM Viewer for ArcGIS Engine  or  ArcMap. 

 Still on the Field Unit, from the  Start  menu choose 
Programs > ArcFM Solution > ArcFM 
Geodatabase Replication > ArcFM Geodatabase 
Replication Client. 

If your version of ArcFM GDB Replication Server is 9.3 SP 1 or earlier, 
a Send/Receive Process Framework replica will only succeed if you 
install ArcFM (which includes certain necessary.dll files) on the 
Replication Server.  You will not need an ArcFM license for the 
Replication Server.   ArcFM GDB Replication Server versions 9.3 Rev 2 
and later include these .dll files, so no additional software is required on 
the Replication Server. 
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 After the client replication process is complete, on the 
Replication Server,  from the  Start  menu choose 
Programs > ArcFM Solution > ArcFM 
Geodatabase Replication > ArcFM Geodatabase 
Replication Server. 

 On the  Enterprise Client,  start  ArcMap. 

 In the  ArcFM Login  screen, connect to the 
enterprise SDE geodatabase using the  Sync version, 
as the enterprise user with the Approval Officer role. 

 From the  Stored Displays  drop-down choose a 
Stored Display. 

 Open Session Manager  or  Workflow Manager. 

Notice that you are not going to choose Send/Receive Mobile Data.  
Instead, Send/Receive was already triggered on the Enterprise Client 
when you ran the ArcFM Geodatabase Replication Server command. 

 Observe that the Session/Design you sent from the 
Field Unit is now available.   

 Open this Session/Design and view its content. 

 Following your review, close the session and  ArcMap.   

CHECKLIST END 


